
 
 

CILAMCE 2020 

Proceedings of the XLI Ibero-Latin-American Congress on Computational Methods in Engineering, ABMEC  

Foz do Iguaçu/PR, Brazil, November 16-19, 2020 

DIMENSIONAMENTO E ANÁLISE COMPUTACIONAL DE UM 

GALPÃO METÁLICO UTILIZANDO O SOFTWARE SAP 2000 

Bianca Saldanha Pinheiro1, Salete Souza de Oliveira1 

1Faculdade de Engenharia Civil, Instituto de Tecnologia, Universidade Federal do Pará 

R. Augusto Corrêa, 01 – Guamá, 66075-110, Belém - PA, Brasil 

bianca_98pi@hotmail.com, salete@ufpa.br 

Resumo. O presente trabalho apresenta um tutorial do SAP 2000 v.16 - Structural Analisys Program, para 

modelagem, dimensionamento e análise estrutural de um galpão com estrutura em perfis metálicos. O SAP 2000 

é um software para análise estrutural que utiliza o método dos elementos finitos, desenvolvido pela empresa 

americana CSI – Computers&Structures Inc. e comercializado no Brasil pela empresa Multiplus Softwares 

Técnicos in. O software é vastamente utilizado para analisar edificações de pequeno, médio e grande porte, no 

entanto, apesar de ser uma importante ferramenta de análise e dimensionamento, nota-se a dificuldade dos alunos 

de engenharia civil em aprender a usá-lo, assim como a escassez de material em português apresentando, 

didaticamente, tutoriais para auxiliar na utilização do programa, visto que, com a evolução das estruturas, que 

estão se tornando cada vez mais complexas, tornou-se, em grande parte das situações, inviável a resolução por 

meio de cálculos analíticos. Desta forma, o presente trabalho visa contribuir para diminuir estas dificuldades, 

apresentando um manual de modelagem, dimensionamento e análise de uma estrutura metálica, a fim de gerar o 

perfil adequado para cada barra, assim como os diagramas de esforços, deflexões, momentos, cisalhamento, 

reações e deformadas. 
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1  Introdução 

O presente trabalho é baseado em [1], cujo objetivo é apresentar a modelagem de um galpão metálico, usando 

o software SAP 2000, após terem sido feitas as devidas verificações, conforme regulamentado pelas normas ABNT 

NBR 8800:2008 e NBR 6123:1988. Este trabalho tem por finalidade, servir como tutorial para ajudar alunos e 

profissionais que tenham dificuldade em manusear o programa, desta forma, contribuindo para a bibliografia 

nacional de materiais com este tema. Apresentam-se os diagramas dos esforços das barras principais da estrutura, 

bem como a leitura destes. 

2  Formulação 

O galpão será de duas águas com vão livre de 12 metros por 3 vãos de 6 metros, fechamento em alumínio e 

perfis metálicos. A escolha dos perfis foi feita a partir de um pré-dimensionamento utilizando o SAP 2000, esta 

ferramenta funciona a partir da inserção de perfis, de uma biblioteca contida no computador do usuário, a fim de 

criar um banco de dados no programa, a partir desta importação, deve-se criar um perfil de auto seleção de 

determinada geometria, nesse caso, tipo H e C, e associar à cada um, os perfis importados, com a geometria 

respectiva, dentre os quais, o software irá selecionar a opção mais adequada para cada barra, com base na norma 

escolhida pelo usuário, no caso de usuários brasileiros, a norma correta a ser escolhida deve ser a AISC360 

05/IBC2006, que é similar à NBR 8800:2008, já que a norma brasileira não consta no programa. 

Neste caso, foram selecionados os seguintes perfis: HP 200 x 53,0 para as colunas, U – 305 x 30,80 para as 

terças e vigas horizontais, U – 76,20 x 6,10 para os montantes e W – 150 x 22,5 para as vigas inclinadas, todos os 
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perfis provém de catálogos Gerdau. Enquanto o aço é o aço-carbono A36 cujas propriedades de resistência ao 

escoamento e resistência à ruptura são, respectivamente, 250 MPa e 400 Mpa. As telhas foram escolhidas com 

base em um catálogo e seu peso é de 5,85 kg/m. As dimensões do galpão estão expostas nas Figuras 1 e 2. 

 

Figura 1. Cotas da vista frontal do galpão 

 

Figura 2. Cotas da vista superior do galpão 

Dados geométricos da edificação: 

b = 12,00 m; a = 18,00 m; h = 3,00 m; h1 = 1,06 m; ß = 10,00 ° e d = 6,00 m. 

Sendo: 

b – Dimensão frontal do galpão; a – Dimensão longitudinal do galpão; h – Altura; h1 – Altura do montante; 

ß – Inclinação; d – Distância entre pórticos. As cargas incidentes na estrutura são as seguintes: 

2.1 Peso próprio 

O peso próprio é a carga permanente da estrutura, definida pela soma do peso de cada perfil e peso das telhas. 

2.2 Vento 0° e 90° 

O esforço proveniente da ação do vento pode ser determinado a partir da ABNT NBR 6123:1988 – Forças 

devidas ao vento em edificações, considerando os dados geométricos, previamente apresentados. Todos os cálculos 

detalhados estão contidos em [1], aqui apresentar-se-ão apenas os resultados, com a pior situação da carga do 

vento. O pior caso para o vento 0° e 90° é com cpi = 0, logo, ao dividir os valores dos esforços no telhado pela 

distância entre os pórticos, encontra-se o valor do esforço para cada área de influência, este será o valor inserido 

no SAP 2000. Ao dividir, obtém-se, para o vento 90°, 0,357 KN/m2 para o lado esquerdo do telhado e 0,118 

KN/m2 para o lado direito, enquanto, para o vento 0°, tem-se 0,237 KN/m2 para ambos os lados. 

2.3 Sobrecarga na cobertura 

A sobrecarga aplicada na cobertura é definida, também, pela ABNT NBR 6123:1988 – Forças devidas ao 

vento em edificações, e equivale a 0,25 KN/m2, trata-se de uma carga extra que deve ser considerada a fim de 

favorecer a segurança da edificação. 
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2.4 Verificações 

As peças foram verificadas quanto à estabilidade à tração e compressão, de acordo com o esforço ao qual 

cada uma foi submetida, apresenta-se neste trabalho, os resultados do esforço resistente de cada peça, indicando 

se este é menor que o esforço solicitante, extraído do programa SAP 2000, assim como os valores de esbeltez para 

cada peça, demonstrando que são menores que os valores limites estabelecidos pela ABNT NBR 8800:2008.  

Observação 1: Tração. As peças expostas ao esforço de tração são  as vigas horizontais e algumas terças, os 

resultados das verificações será exposto a seguir, comparando a resistência à tração da peça com o esforço 

solicitante: 

Vigas horizontais, valores para escoamento da seção bruta e ruptura da seção líquida, respectivamente: 

        . 4 6
, 39,30 10 250 10 / 1,1 893181,82 5099t RdN x x x N KN OK   (1) 

            4 6
, 39,30 10 400 10 / 1,35 1164444,44 1164,44 5, 099t RdN x x x N KN KN OK   (2) 

Semelhantemente, valores das terças: 

          4 6
, 39,30 10 250 10 / 1,1 893181,82 893,18 0, 308t RdN x x x N KN KN OK   (3) 

          4 6
, 39,30 10 400 10 / 1,35 1164444,44 1164,44 0, 308t RdN x x x N KN KN OK   (4) 

A próxima verificação é quanto ao limite do índice de esbeltez, deve-se obedecer à condição da ABNT NBR 

8800:2008: 

Vigas horizontais: 

       / 600 / 2,03 295,57 300yL r OK   (5) 

Terças: 

       / 600 / 2,03 295,57 300yL r OK   (6) 

Desta forma, verifica-se a estabilidade das peças quanto à tração. 

Observação 2: Compressão. As peças comprimidas são as colunas, as vigas inclinadas, os montantes e 

algumas terças, os resultados das verificações será exposto a seguir, comparando a resistência à tração da peça 

com o esforço solicitante, conforme feito anteriormente: 

Colunas: 

       , 0,91 1 68,1 25 / 1,1 1408,43 36,86c RdN x x x KN KN OK   (7) 

Vigas Inclinadas: 

       , 0,25 1 29 25 / 1,1 164,77 1,81c RdN x x x KN OK   (8) 

Montantes: 

        , 0,69 1 7,78 25 / 1,1 122,00 32,65c RdN x x x KN OK   (9) 

Terças: 

        , 0,29 1 39,30 25 / 1,1 259,02 0,601c RdN x x x KN OK   (10) 

A próxima verificação é quanto ao limite do índice de esbeltez, semelhante ao que foi feito anteriormente, 

obedecendo-se à condição da ABNT NBR 8800:2008: 

Colunas: 

       / 300 / 4,96 60,48 200yL r OK   (11) 
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Vigas Inclinadas: 

       / 609 / 3,65 166,85 200yL r OK   (12) 

Montantes: 

       / 106 / 1,03 102,91 200yL r OK   (13) 

Terças: 

       / 313,6 / 2,03 154,48 200yL r OK   (14) 

Após os cálculos, contata-se que os elementos comprimidos atendem às necessidades para as quais foram 

projetados. 

3  Modelagem do galpão no SAP 2000 

3.1 Seleção do template 

Ao iniciar o programa, clica-se em File -> New Model, em seguida deve-se selecionar as unidades em que o 

SAP 2000 irá trabalhar e no campo Select Template seleciona-se Grid Only. Em seguida, uma caixa de diálogo 

Quick Grid Lines aparecerá, nela serão inseridos o número de linhas de base em cada eixo, assim como a distância 

entre elas, as medidas serão conforme a seleção de unidades feita anteriormente. 

Os valores a serem inseridos no campo Number of Grid Lines em X direction, Y direction e Z direction são 

3, 4 e 3, respectivamente, da mesma forma, no campo Grid Spacing, deve-se inserir os seguintes valores nas 

lacunas: X direction (6); Y direction (6) e Z direction (3). O terceiro campo refere-se às coordenadas de localização 

da primeira linha de base, mantem-se o valor 0 em todas as lacunas para que o desenho se inicie na origem do 

plano cartesiano. A fim de alterar a medida de uma única linha de base para fazer o desenho da cobertura 

corretamente, deve-se clicar, na tela atual, com o botão direito do mouse e selecionar Edit Grid Data na caixa de 

diálogo aberta, então seleciona-se Modify/Show System, e deve-se alterar o valor de Z Grid Data para 4,0575. 

3.2 Definição dos materiais e perfis 

A definição dos materiais é feita da seguinte forma, clica-se em Define, na paleta superior, em seguida na 

opção Materials->Add New Material. Abrir-se-á a janela Add Material Property, na qual deve-se alterar os 

campos Region->United States, Material Type->Steel, Standard->ASTM36 e Grade->Grade 36. Clicar em OK 

para finalizar o comando. Na janela Define Materials clica-se em Modify/Show Material. Em General Data, 

alterar o item Material Name and Display Color para Aço. 

Seguindo o mesmo roteiro anterior, adiciona-se o material do fechamento superior, na janela Add Material 

Property, preencher como a seguir Region->United States, Material Type-> Aluminio, Standard->ASTM e 

Grade->Grade Alloy 6061 T6. Selecionar Modify/Show Material e alterar o campo Material Name Display Color 

para Alumínio. A seguir, para inserir os perfis I e U, deve-se importar de uma biblioteca de perfis, conforme [1]. 

3.3 Desenho dos elementos 

Para desenhar os elementos, seleciona-se Draw Frame/Cable, na paleta lateral esquerda que abrirá uma caixa 

de diálogo, Properties Of Object, nela, deve-se selecionar o perfil de cada elemento no campo Section ao fazer 

seu desenho. Em seguida, seleciona-se as vigas da cobertura para dividi-las em elementos finitos, deve-se clicar 

na paleta superior em Edit->Edit Lines->Divide Frames, assim abrirá uma caixa de diálogo Divide Selected 

Frames. Depois deve-se apertar em Last/First Length Ratio (1) e em Number of Frames (4) e clicar em OK.  

Deve-se ativar a visualização dos nós das vigas na paleta superior Set Display Options, desmarcando, no 

campo Joint, a opção Invisible. Para criação das Terças, seleciona-se os pontos das vigas e clica-se em Edit-> 

Extrude-> Extrude Points to Frames/Cables. Na janela Extrude Points to lines, colocar em Property For Added 
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Objects (Terca) e, em Increment Data, dx (0), dy (-6), dz(0) e Number (6). Clicar em OK. 

Para replicar o pórtico, seleciona-se todas as peças do modelo, clica-se em Edit->Replicate. Na aba Linear, 

coloca-se, na caixa de Number, o valor 3 e, no item dy, o valor 6. Em seguida, é primordial corrigir a orientação 

dos perfis, conforme feito em [1]. O galpão modelado encontra-se na Figura 3. 

 

Figura 3. Galpão modelado 

3.4 Definição dos apoios 

Para definir os apoios, é preciso, primeiro, selecionar os pontos inferiores das colunas, em seguida clica-se 

em Assign->Joint->Restraints, na janela aberta, deve-se selecionar a primeira opção no campo Fast Restraints, 

por fim, seleciona-se OK. Depois, faz-se a seleção dos pontos superiores das colunas então clica-se, na paleta 

superior, em Analyze->Set Analysis Options e deve-se selecionar a primeira opção, Space Frame, depois OK. Por 

fim, selecionam-se os pontos superiores e inferiores dos montantes e procede-se como anteriormente Analyze-

>Set Analysis Options, na paleta superior, então clica-se na quarta opção, Space Truss, depois OK. 

3.5 Inserção do fechamento na cobertura 

Para criar o material referente as telhas, deve-se clicar em Define->Section Properties->Area Sections.  Na 

caixa de Select Section Type To Add mantém Shell e clica-se em Add New Section. Na janela aberta, na lacuna 

Section Name, coloca-se Alumínio, em Type marca-se Membrane, na lacuna Thickness coloca-se Membrane 

(0,02) e Bending (0,02). No espaço Material Name seleciona-se Alumínio e clica-se em OK. Na paleta esquerda, 

seleciona-se o ícone Draw Poly Area que abrirá a janela Properties of Objects, nessa, em Section, é escolhido 

Alumínio e em Drawing Control Type atribui-se None <space bar>. Selecionam-se, na peça, os nós que fecharão 

as áreas, para isso, clica-se nos pontos. Deve-se repetir o processo, até preencher, completamente, o telhado. 

3.6 Aplicação de cargas 

Para definir os casos de carregamento, clica-se em Define->Load Patterns na paleta superior. O programa 

gera, automaticamente, uma carga DEAD, que representa o peso próprio da estrutura e, por isso, tem o valor 1 no 

campo Self Weight Multiplier. Adiciona-se cargas nomeadas de Telhas, Type (Dead), Self Weight Multiplier (0); 

Sobrecarga na Cobertura, Type (Live), Self Weight Multiplier (0); Vento 0°, Type (Wind), Self Weight 

Multiplier (0), Auto Lateral Load Pattern (None); Vento 9°, Type (Wind), Self Weight Multiplier (0), Auto 

Lateral Load Pattern (None). Após o preenchimento de todas as lacunas de cada carga, deve-se clicar em Add 

New Load Pattern. Para inserir o carregamento na estrutura, selecionam-se as áreas do telhado, e executa-se o 

caminho Assign->Area Loads->Uniform Shell, marca-se a opção Add to Existing Loads, Load Pattern Name 

(Telhas), Direction (Z), Load (-0,0585). Em seguida, segue-se as instruções anteriores, preenchendo as lacunas 

conforme a intensidade e direção de cada carga, no telhado e nas colunas.  

Para inserir as combinações de ações, feitas segundo a ABNT NBR 8800, deve-se selecionar Define na paleta 

superior, depois Load Combinations->Add New Combo e inserir 6 combinações de ações, duas considerando a 

sobrecarga como carga variável principal, duas considerando o vento 0° como carga variável principal e outras 

duas considerando o vento 90° como carga variável principal, após inserir cada carga e o fator, deve-se clicar em 
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Add e, após adicionar todas as cargas da combinação clica-se em OK e repete-se o processo até inserir todas as 

combinações da seguinte maneira, por fim, clica-se em OK, novamente: 

COMB1: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na cobertura, Scale Factor 

(1,5); Vento 0, Scale Factor (0,84). 

COMB2: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na cobertura, Scale Factor 

(1,5); Vento 90, Scale Factor (0,84). 

COMB3: DEAD, Scale Factor (1,00); Telhas, Scale Factor (1,00); Vento 0, Scale Factor (1,4). 

COMB4: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na cobertura, Scale Factor 

(1,2); Vento 0, Scale Factor (1,4). 

COMB5: DEAD, Scale Factor (1,00); Telhas, Scale Factor (1,00); Vento 90, Scale Factor (1,4). 

COMB6: DEAD, Scale Factor (1,25); Telhas, Scale Factor (1,25); Sobrecarga na cobertura, Scale Factor 

(1,2); Vento 90, Scale Factor (1,4). 

3.7 Análise da estrutura 

Após inserir todas as cargas e combinações, clica-se Run Analysis na paleta superior e clica-se em Run Now. 

Em seguida, clica-se em Steel Frame Design->View/Revise Preferences para indicar ao SAP 2000 a norma a ser 

usada na análise das barras, seleciona-se AISC360 05/IBC2006 em Design Code, posteriormente, deve-se 

selecionar, na paleta superior, Design->Steel Frame Design->Start Design/Check of Structure. Por fim, é 

possível visualizar a análise dos perfis de cada elemento estrutural, através de uma paleta de cores que indica os 

esforços aos quais as barras estão sendo submetidas, da seguinte maneira, a cor azul indica que a barra está sofrendo 

um esforço entre 0 e 50% do que esta suporta, ou seja, o coeficiente de segurança seria igual a 2. A cor verde 

indica esforço entre 50% e 70%, enquanto na amarela o esforço é de 70% a 90%, o laranja simboliza esforço entre 

90% e 100% do que o elemento suporta. Já a vermelha indica que o esforço submetido é maior do que a barra é 

capaz de resistir. Esta paleta é usada para indicar ao usuário se o perfil escolhido é adequado. 

 

Figura 3. Visualização da proporção de esforços em cada barra 

4  Análise dos resultados 

4.1 Colunas 

Nem todas as colunas estão submetidas à esforços de mesma intensidade, no entanto, serão apresentados os 

valores da pior situação, as duas colunas centrais sofrem a maior compressão, no valor de 36860 N, já as colunas 

centrais da esquerda e da direita estão sob ação de um momento fletor máximo de 250 N.m. 
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4.2 Vigas Inclinadas 

Semelhante ao que foi explicado anteriormente, as vigas inclinadas externas sofrem mais esforços que as do 

meio, estas estão submetidas ao esforço de tração de 550 N, momento máximo de -40 N.m, esforço de cisalhamento 

de 50 N, deflexão 0,00000464 m e não sofrem torção. 

4.3 Vigas Horizontais 

As vigas horizontais do meio são as que sofrem mais esforços, tracionadas em 5099 N, submetidas a momento 

fletor de -6 N.m, cisalhamento de -1,98 N, deflexão de 0,0000042 m, não sofrem torção nem carga distribuída. 

4.4 Montantes 

Os montantes internos são os mais comprimidos, sofrendo 32650 N, enquanto os montantes externos sofrem 

maiores esforços de momento fletor e cisalhamento, sendo o momento fletor igual a 3,7 N.m e o cisalhamento de 

intensidade igual a 7 N. 

4.5 Terças 

As terças que sofrem mais esforços estão localizadas nos extremos centrais da estrutura, ou seja, as terças 

dos extremos entre os pórticos do meio, estas sofrem tração de 963 N, torção de 65,8 N.m, momento fletor de 1120 

N.m, cisalhamento de -1120 N e deflexão de 0,00011 m. 

5  Conclusão 

O presente trabalho se mostrou de grande importância para alunos e engenheiros que buscam por bibliografia 

em português para auxiliar o uso do SAP 2000. Pode-se chegar a duas conclusões principais: (a) é preciso ter os 

conhecimentos básicos do software para manuseá-lo corretamente, evitando assim, resultados equivocados; e (b) 

o usuário do programa deve estar habilitado para realizar os cálculos prévios ao lançamento da estrutura no 

programa, além de ser capacitado para ler os resultados gerados pelo SAP 2000. Inserir perfis sem as devidas 

verificações prévias, é negligenciar a segurança da estrutura, por isto, o programa deve ser manuseado por 

profissionais com os devidos conhecimentos da área e do funcionamento do programa. Este software, assim como 

os demais programas de análise estrutural e/ou dimensionamento, são ferramentas importantes, no entanto, 

precisam ser executados por pessoas capacitadas para tal, pois trata-se de estruturas que servirão de abrigo para 

cargas, pessoas e materiais, logo, a segurança é prioritária para o projeto. 
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